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CHAPTER 1:
INTRODUCTION

Ever thought about directing your own movie? How about having all the creative 
controls and being in charge of the entire editing and post-production process? 
Well, today’s computing technology has made all this possible for anyone who 
has recording devices, capture devices, a computer, and of course, the sensational 
new software application, PowerDirector.

Admittingly, video editing software is not without its drawbacks. Since the 
advent of computers and its incredible growth in usage and processing speed 
power, video editing software applications have taken off to astronomical 
heights. Yet, a great inherent limitation, such as requiring a huge amount of disk 
space because of the raw video data it captures, still remains. This is why many 
still choose to edit with analog devices.

What makes PowerDirector the megastar of its industry in one quick flash is its 
ability to save precious producing time because of its Smart Video Rendering 
Technology (SVRT). Say goodbye to raw video data, which is usually captured in 
.AVI format, and say hello to plenty of hard drive space and MPEG. No additional 
compression nor decompression is required when producing scenes that do not 
contain effects, which saves you huge amounts of time compared to our 
competitors that compress and decompress the entire movie regardless! Add to 
this wonderful features that include adding up to six titles per clip, capturing 
directly from DV camcorders, six audio streams per clip, picture-in-pictures 
(adding video or images to an existing video clip), a huge collection of transitions 
and titles effects, master audio files, watermarks, and much more, and there is 
absolutely nothing left to be desired.
1



Chapter 1
The Digital Video Universe
Profit outlooks and shrinking demand in the technology industry not-
withstanding, the digital video revolution is well underway. There are still home 
videos to be edited, videos to be distributed, and full length movies to be 
produced. In previous generations, video editing and recording was accomplished 
through analog means by video professionals who had access to high-priced 
machinery and video equipment. Thus, many of those who wished to edit home 
footage or videos, if they were lucky enough to have it recorded in the first place, 
never had the chance to display their creative prowess when it came to video 
editing unless it involved enrolling in film schools and obtaining access to 
production studios.

When the computer descended upon our lives and immersed itself in our world, it 
was only a matter of time until processing speeds were incredibly fast and disk 
space was vast enough to begin editing video at home with software applications 
that didn’t require expensive video specialists, equipment or any other gadgets.

And coinciding with the computer industry’s major influence was the birth of the 
DV (digital video) format, an international standard intended for consumer use, 
back in 1995.

The DV Format: A Brief History
Like a seamless emergence and natural coalescence with desktop video editing, 
the advent and proliferation of DV camcorders were sure to spark continued 
interest in the infinite possibilities of digital video. What began back in 1995 and 
a DV format agreement reached by a consortium of companies that included 
Hitachi, Ltd., Sony Corp, Sharp Corporation, Thompson Multimedia, Mitsubishi 
Electric Corporation, Victor Corporation of Japan (JVC), Matsushita Electric 
Industrial Corp. (Panasonic), Philips Electronics, Sanyo Electric Co. Ltd., and 
Toshiba Corporation, is still being ironed out until this day in terms of a 
consensual format.

The frontrunners at the time and still are until this day, are Sony and Matsushita 
(Panasonic), which beat out the competition with their consumer releases hitting 
the market first. Soon after though, the format wars began with professional DV 
variants such as DVCAM (Sony) and DVCPRO (JVC) despite the DV format 
agreement. Luckily, the basic DV format is still intact, but other factors were 
altered (i.e. tape type, track pitch and width) so we are still left with backward-
compatible formats or incompatible formats between models from differing 
companies. Hopefully, this won’t impact or trickle down to the consumer 
segment anytime soon.

What exactly is the DV format then? To start with, it has a 5:1 compression ratio 
and its compression technology is quite similar to MPEG (e.g. DVD format). 
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Introduction
Tips: For more information on MPEG, refer to "What Is MPEG?" on page 99.

The difference is that it relies more on intraframe compression where each 
compressed frame will depend entirely on itself and not on data from preceding 
or following frames like MPEG. However, the DV format does incorporate the 
use of adaptive interfield compression where two extremely similar interlaced 
fields of a frame will be compressed together to save space.

The analog generation is slowly witnessing its demise. There is still room left for 
analog technology though, but as the DV format perfects its compression 
technology and enhances their non-linear editing (NLE) friendliness, the analog 
generation will soon be outdated, fainting memories from a bygone era. Add to 
this the continued popularity of video editing software and the uncompromising 
blazing speed of computer processing power, and the perfect union between DV 
recording and editing couldn’t be any more natural or fitting.

FireWire
In the early courting stages of video editing software and DV format recording, 
there had to be an intermediary between the two technologies to make it a 
success, because as you know from analog transference, there is always data lost 
from the original source. FireWire, or IEEE-1394, is this unerring technology 
when it comes to data loss, as in “lossless” transfer. A serial data transfer protocol 
and interconnection (bi-directional) system, FireWire transmits digital video 
(DV) offering a higher transfer rate and incorporating the use of hot-plugging 
technology (i.e. connecting and disconnecting without shutting down the host 
computer). Please refer to "FireWire Adapter Cards" on page 7 and "IEEE 1394 
Cable" on page 10 for more information.
3



Chapter 1
System Requirements
� Windows 98SE, ME, 2000, XP

Hardware Requirements
� Authoring: Pentium II 450 or above

� Video capture devices (optional)

� capture cards (PCI, USB, FireWire, TV tuner)

� DV camcorder

� analog camcorders: 8mm, V8, Hi8, VHS-C

� digital camera

� PC camera

� VCR

� Playback 

� Internet Streaming: Pentium 266 with MMX Technology, Microsoft 
Windows Media Player 7.0, IE 5.0

� Desktop Slide Show: Pentium 266 with MMX Technology
 4



CHAPTER 2:
GENERAL VIDEO 
SETUP

This chapter has been provided for users to give general information on video 
capture devices setup information. For definitive procedures and information, 
refer to your video capture devices’ user’s manual or the latest PowerDirector 
compatibility list at www.gocyberlink.com.

Capture Device Interfaces
Audio and video adapter cards come in various sizes and shapes utilizing these 
following capture interfaces:

� PCI (Peripheral Components Interface): The most economical and 
effective device interface type, PCI and its associated cards offer input rates 
at more than 30 frames per second, which matches the MPEG output rate.

� USB (Universal Serial Bus): Users can connect USB devices to computers 
through USB ports without turning the power off. Although this is very 
convenient, the bandwidth is lower than other devices. The quality is often 
jeopardized by its lower transmission rate.

� IEEE 1394: The fastest DV transference device interface, also known as 
Sony iLink or FireWire, is increasing in popularity because of its superior DV 
quality and lossless transmission. The adapter card comes with 4 pin or 6 pin 
slots. The transmission rate can go up to 400MB and be adopted up to 63 
devices.

Note: Before you begin encoding video files, be sure to: 1) Properly connect your 
assorted hardware to your PC through the video ports. 2) Turn on all necessary 
devices.
5
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Chapter 2
Video Capture Devices
These types of hardware peripherals transfer video content from analog 
camcorders or VCRs into your computer. There are many styles of video capture 
devices that include the Peripheral Component Interface (PCI) interface devices, 
Universal Serial Bus (USB) (as pictured below) video capture device, and other 
general capture cards.

 Video Capture Device with USB Interface

Depending on the video capture card, some have special Audio/Video (A/V) In 
and Out ports (pictured below).

Other cards will come with S-Video and Composite ports (designed for receiving 
video content as pictured above).

1 Monitor

2 A/V out

3 TV

4 A/V in

1 Composite Video

2 Line in

3 S-Video

4 Line out

5 TV

1 S-Video

2 Composite 2

3 Composite 1
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General Video Setup
Pictured above is a basic capture card for video content that incorporates the S-
Video and Composite ports and requires you to plug the audio cable directly into 
your sound card.

TV Tuner Cards
TV tuner cards, occasionally indistinguishable from capture devices, receive the 
television radio frequency (RF) signal directly and demodulate NTSC, PAL, or 
SECAM signals. Some capture devices include a TV port, while other true TV 
tuner devices may only support TV capture but not video capture capability.

FireWire Adapter Cards
Nearly all camcorders use 4-pin IEEE 1394 connectors. PCI interface cards may 
use either 4-pin or 6-pin connectors. The diagrams below display a 4-pin and 6-
pin connector for PCI interface cards and a 4-pin connector for a DV camera. 
7



Chapter 2
Sound Cards
Sound cards are responsible for the audio aspect of your computer and control the 
quality of sound during computer playback when editing or transferring output to 
other devices.

Like video capture cards, they come in all shapes and sizes. Some computers may 
have built-in audio ports while some have multiple ports for:

� a microphone input jack

� speakers

� headphones

� output jacks

� line-in cables

PowerDirector supports both 16-bit ISA bus sound cards and 32-bit PCI bus 
sound cards. Refer to your sound card user's guide for more details.

Graphics Cards
In order to guarantee minimal graphic quality, your graphic card must be capable 
of displaying at least High Color (16 bit) and a 1028x760 resolution or above. 
Almost all current PCI and AGP video cards support this basic requirement.
 8



General Video Setup
Cables & Connectors
Listed below are various cables that you will need to establish connections. The 
first two cable formats are discussed in "Video Signal Formats" on page 12.

Analog Cables

Below are diagrams for the composite and S-Video ports:

S-Video Cable Composite (RCA) Video Cable

Audio Y-Adapter Cable

Sometimes referred to as a mini 

jack to RCA stereo cable, it 

carries audio signals to your 

computer from an array of audio 

equipment.

RCA-to-RCA Stereo Cable

This cable carries audio signals 

to your computer from an array 

of audio equipment.

Composite port

S-Video port
9



Chapter 2
IEEE 1394 Cable
IEEE1394/FireWire cables may measure up to 32 feet long or as short as 8 
inches. 6-pin connectors are for devices that transfer power from the FireWire 
bus, while 4-pin heads for camcorders and other iLink appliances transfer data 
only. Nearly all computers use a 6-pin connector for their 1394 interface. You 
need a 6-pin or 4-pin configuration to connect a computer to a DV camcorder. A 
4-pin to 4-pin configuration would be used for transferring between two DV 
camcorders. For more information on FireWire, please refer to "FireWire" on 
page 3.
 10



General Video Setup
Installing Primer

Bringing Video In
As pictured above, the video source will have to be connected properly to your 
capture devices, or sound cards before beginning. Refer to your hardware 
peripheral's manual for more information on installation. 

Note: Capture and sound cards come in various sizes and shapes. Some capture 
cards have built-in TV tuners and/or Audio In capability.
11



Chapter 2
Video Signal Formats
Today, the predominant signal formats are as follows: television, S-Video, and 
Composite. They are connected through video ports by televisions, camcorders, 
most VCRs, and other consumer electronics.

Television Signal Format
This format is the general NTSC or PAL signals your TV receives through a 
normal cable or TV antenna.

Composite Video Signal Format
Used for less expensive types of video devices, it produces a single video signal, 
like for instance, for VHS camcorders or VCRs.

S-Video Signal Format
This format produces separate video signals resulting in better quality and is used 
with video devices such as S-VHS, Hi-8 camcorders or Hi-8 VCR.

Digital Video Format
Unlike analog video formats listed above, digital video (DV) is completely 
digital and offers a wider range of colors, video and audio. 
 12



CHAPTER 3:
A VISUAL 
OVERVIEW
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Chapter 3
Main Controls

Icon Description

Activates i-Power on the Web for resources

Minimizes PowerDirector

Exits PowerDirector

Adjusts volume
 14



A Visual Overview
Modes Wheel

Icon Description

Switches to the default Preview Mode

Switches to Capture Mode

Switches to Trim Mode

Switches to Titles Mode

Switches to Color Mode

Switches to Picture-in-Picture Mode

Switches to Audio Mode

Switches to Transitions Mode

Switches to Produce Movie
15



Chapter 3
Library

Icon Description

Shows all media files

Shows all video files

Shows all audio files

Shows all image files

Imports media files

Displays Library media files as large icons

Displays Library media files with file details
 16



A Visual Overview
Preview Window

Icon Description

Plays file

Pauses file

Stops playing file

To start of file

To end of file

Moves to next frame
17



Chapter 3
Moves to previous frame

Records file (if applicable depending on mode)

Applies clip to Storyboard (if applicable)

Icon Description
 18



A Visual Overview
Storyboard

Icon Description

Plays your movie (preview before producing)

Activates Master Watermark mode

Activates Master Audio mode

Scrolls Storyboard left

Scrolls Storyboard right
19



Chapter 3
Capture Mode

Icon Description

Captures audio source only

Captures video and audio source (if applicable)

Captures DV source

Setup for sources or profile
 20



A Visual Overview
DV Capture Mode

Icon Description

Denotes total captured time from DV

Seeks tape’s timecode

Shuttles DV tape

Marks in for beginning of batch task

Marks out for beginning of batch task

Records/captures video/audio content

Stops recording file
21



Chapter 3
Switches to Batch Capturing

Switches back to Instant Capturing

Adds new batch capturing task

Removes batch capturing task

Starts selected batch capturing task(s)

Takes snapshot

Icon Description
 22



A Visual Overview
Trim Mode

Icon Description

Marks in for beginning of trimmed clip

Marks out for end of trimmed clip

Denotes current time slider position

Total time of trimmed clip

Resets mark in position

Resets mark out position

Takes snapshot
23



Chapter 3
Reverts to clip’s original trim effects 

Clears all trim effects

Icon Description
 24



A Visual Overview
Titles Mode

Icon Description

Marks in for beginning of title effect

Marks out for end of title effect

Adds new title to clip

Removes title from clip

Sets font options

Reverts to clip’s original title effects 

Clears all title effects
25
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Color Mode

Icon Description

Reverts to clip’s original color effects 

Clears all color effects 
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A Visual Overview
Picture-in-Picture Mode

Icon Description

Selects image color to be filtered

Reverts to clip’s original picture effects 

Clears all picture effects 
27
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Audio Mode

Icon Description

Adds new audio file to clip

Removes audio file from clip

Trims audio file

Volume mixing for user-defined audio file

Reverts to clip’s original audio effects

Clears all audio effects
 28



A Visual Overview
Transitions Mode

Icon Description

Reverts to clip’s original transition effects 

Clears all transition effects 
29



Chapter 3
 30



CHAPTER 4:
THE BASICS

It’s time to get started with the basics before your mesmeric and uninhibited 
effects are added. The ensuing sections will outline how to begin by importing 
your media files into the PowerDirector Library and previewing these files. Later, 
you will get accustomed to the Storyboard, your menus and then wrap things up 
with choosing your specific Preferences. 

Importing into the Library
The first step in almost all video editing software applications is to import media 
files into the software application itself. This area of the software application 
where the imported files reside is the Library.

1 After you have started the PowerDirector application, click Import Media 
or go through the menu and choose File > Import > Media Files.

2 Select the files to be imported by clicking. To select multiple files, press 
<SHIFT> while clicking to select continuous files or press <CTRL> while 
clicking to select discontinuous files.

3 Click Open.
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Chapter 4
4 To Show Video, Audio, Images or All, click the appropriate icon in the top 
left corner.

5 The files will appear in the Library. Click Large Icons or click Details to 
change the view to a text view along with some of its associated file 
properties.

6 You may also right-click on a specific file for a 
menu. Select one of the options to Preview, 
Apply to Storyboard, Import New File(s) to 
Library, or Remove from Library.;

To preview your imported files, go to "Previewing your Library Files" on page 33 
for more information.
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The Basics
Previewing your Library Files
Previewing Library files simply plays your original files like any other Media 
Player. 

1 After you have imported your files into the Library, begin previewing by 
dragging the files into the Preview window or double-click on them. The 
mode will instantly switch to Preview.

2 Click Play to begin playing your file if it’s a video or audio clip.

3 You may also skip directly to the Start of the file or to the End.

4 Other common commands are Pause, Stop, Next Frame and Previous 
Frame. The best way to utilize the Next Frame and Previous Frame 
commands are during the Pause and Stop modes. However, you may click 
them during playback, which will then switch into Pause mode.

5 Drag and release the Time Slider to navigate quicker when previewing 
your file.
33



Chapter 4
6 You may also right-click on the Preview window for a shortcut menu. 
Select one of the preview options or Apply to Storyboard.

7 If you are satisfied with your file and don’t require any further 
manipulation, click Apply and the file will be applied to your Storyboard. 
Be sure to set your preferences for applying to the Storyboard. Go to 
"Preferences" on page 40 for more information.
 34



The Basics
Storyboard Functions
When you produce, you are producing all the clips on your Storyboard. If you 
don’t have any files applied onto the Storyboard, you can’t produce your movie! 
Thus, the Storyboard is the most important facet and area of your entire pre-
production.

Keep in mind that not all files have to be manipulated, for files may be directly 
applied or dragged onto the Storyboard immediately after it is imported into your 
Library. Go to "Importing into the Library" on page 31 for more information.

1 Now that your files have been imported into the Library and have 
previewed it, you can directly drag the media files into the Storyboard 
without further manipulation and produce your own movie. A red line will 
appear so as to convey where the dragged file will be placed. 

Note: Audio files may not be applied individually onto the Storyboard unless it is 
for the Master Audio or as an audio supplement to an existing clip.

2 To move multiple clips on the Storyboard, simple hold down the <SHIFT> 
key while clicking the clips you want to move together. The clips will be 
highlighted. Now, drag and release onto the new position.
35



Chapter 4
3 To remove clips from the Storyboard, simply click it and drag it out of the 
Storyboard or press <DELETE> on your keyboard when highlighted. A 
dialog box will appear for you to confirm your removal. Click Yes. 

4 To preview or to manipulate a clip from the Storyboard, select it by double-
clicking and it will appear in the Preview window. Go to "Previewing your 
Library Files" on page 33 for more information.

5 You may also right-click on a specific clip in the Storyboard for a menu. 
Select one of the options that will include cutting, copying or pasting clips 
on the Storyboard.

6 Click anywhere other than a clip on the Storyboard and a more diverse 
menu will be displayed that will include Storyboard display and also Go to 
options. Select one.

7 Click Play Movie to view clips on your Storyboard before producing. You 
may select your options under Edit > Preferences > Preview. Go to 
"Preferences" on page 40 for more information. Or, you may right-click on 
the Play Movie icon to call up a shortcut menu that will allow you to set the 
window size during your movie playback. 
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The Basics
Note: Playing the movie is not the final step in your movie-making process and is 
only a preview of you production. Remember to produce your movie!

8 During the movie playback, press <ESC> on your keyboard to quit or 
double-click.

9 Two other icons are located on the Storyboard. For more information on 
Master Watermark or Master Audio, go to "Master Watermark" on page 
77 and "Master Audio" on page 72 for more information.

10 If you are satisfied with all your clips and your movie, click Produce 
Movie on the Modes Wheel. Refer to "Producing Your Movie" on page 79.
37



Chapter 4
Menu Selections
Below are brief descriptions of various functions. For more information, please 
follow their links.

File Menu
� If you want to create a new project, choose New. 

Choose Open to open an existing project.

� Save your project here or choose Save As... to 
rename the project. Type in the project’s name and 
click OK.

� The Capture commands are the same as the 
Modes Wheel but goes directly into one of the 
three capture modes: Audio, Video or DV. Go to 
"Capturing Content" on page 45 for more 
information.

� The Import command serves the same function as Import Media in 
importing media files to your project’s Library. You may also Import Files 
From Another Project. Select another project and click Open to import 
another project’s media files. Refer to "Importing into the Library" on page 
31 for more details.

� Choose Export > Produce Movie to produce your movie. Go to "Producing 
Your Movie" on page 79 for more information.

� Project Properties is for adding more information for your movie. You 
might want to fill out Keyword, which is suitable for database searches, or 
any other fields.

� Choose Exit to close PowerDirector.

Edit Menu
� The first four commands are if a clip is selected from 

the Storyboard: Cut, Copy, Paste or Delete.

� Select a file from the Library and choose Remove 
from Library. This file will only be removed from 
this project’s Library.

� For Preferences, go to "Preferences" on page 40.
 38



The Basics
Modes Menu
� Select a clip and then any one of the Modes. Go to the 

individual sections for more details on specific Modes.

Storyboard
� Before playing your movie, you may set the size you 

want to play it in. After you set it, and before your final 
production, you might want to play your movie first.

� Select the Go to functions to navigate faster to the first 
and last clips on your Storyboard.

� Select Master Watermark to add a watermark or 
Master Audio to add an audio file for your movie. Go to 
"Master Watermark" on page 77 and "Master Audio" on 
page 72 for more information.

Help
� Here you will find any help you might need that will 

include Content, Search..., and Index...

� You may also Register, Upgrade, and go to i-Power 
for resources or CyberLink’s home web site.
39



Chapter 4
Preferences
When using PowerDirector, we give you the luxury of deciding the processes and 
routines of how files are applied to the Storyboard, how captured files are stored, 
the display of file information, previewing options and a host of others.

General Preferences

1 The first option here is for users to select a default media Directory for all 
their files. Type in the directory path or click Browse and search for the 
directory. Click OK after you select the proper directory.

2 For the Applying Clip Preferences section, select one of the options. The 
first option is the fastest method and saves time from clicking Apply. The 
second option forces users to always click Apply after they make changes if 
 40
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they want to apply. The last option is if you would like PowerDirector to 
remind you if you would like to apply the changes that you have just made. 

3 In the last section, PowerDirector will automatically apply any file/clip to 
the Storyboard after you switch out of the Preview Mode and into any other 
mode. Check it to activate.

4 Click OK or another tab to set more preferences.

Display Preferences

1 The Library Tool Tips Display determines how all your media files’ tool 
tips are displayed in the Library. Check and uncheck the selections to show 
or hide the desired information.

2 The Storyboard Display is the next section. Check and uncheck to Show 
accumulated time up to current position if you would like to see a 
running total for your entire movie. The last selection is to choose either 
Show file name or Show time length of clip. You may not choose both.

3 Click OK or another tab to set more preferences.
41
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Capture Preferences

1 The first selection is Autosave. Choose a directory by clicking Browse and 
selecting a proper directory to save all your captured files under. If you 
want PowerDirector to Automatically generate file names under this 
directory, click it and captured files will automatically be saved. 
Otherwise, after each capture, a dialog box will appear for you to name the 
new captured file.

2 The next selection is for snapshots that you have captured from your video 
content in the Capture or Trim Modes.

� Snap to Clipboard captures the image onto your Windows' clipboard. 

� Snap to Wallpaper (Center) will capture the image, place the image 
centered on your desktop in its original size, and save it automatically 
in your default Windows' System folder.

� Snap to Wallpaper (Tile) will capture the image, place the image on 
your desktop in its original size following a tile format, and save it 
automatically in your default Windows' System folder.

� Snap to File will capture the image directly into a folder you have 
selected. For this selection, you may input the file name by clicking on 
Browse and choosing a directory first. After you have found the 
directory and inputted a name, click Save. Change the file format by 
clicking on the drop-down menu and selecting.

3 The last section is the Capture Destination. Check the selections if you 
would like to automatically add the recently captured files to the Library, 
Storyboard, or both.
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4 Click OK to exit Preferences.

Preview Preferences

1 To set the Window Size for your Preview window, click on the drop-down 
menu and select.

2 When you are editing clips from the Storyboard, you may decide to reserve 
system resources by ignoring video effects or audio tracks during 
previewing or in when modifying in any of the Modes. In the Clip 
Previewing area, simply click to select which option you want to ignore. Be 
sure to check out "System Requirements" on page 4.

3 Whenever you click Play Movie on the Storyboard, you may wish to Play 
from selected clip or Play from first clip. Select one.

4 During the actual Production Process, you may choose which type of 
display is utilized. The Don’t display preview selection saves the most 
system resources. For the Display a quick video preview, not every frame 
will be displayed. Check Display the full video preview in real-time if 
you want to watch the entire movie’s preview. 

Note: There is no audio during the Production Process.
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CHAPTER 5:
CAPTURING 
CONTENT

PowerDirector allows you to capture almost anything under the sun provided that 
you have a capture card or other assortment of adapter cards in transferring data 
into your hard drive. Listed below are video capture devices that may assist you 
in making the best possible movie out there:

� capture card (PCI, USB, FireWire, TV tuner)

� DV camcorder

� analog camcorder: 8mm, V8, Hi8, VHS-C

� digital camera

� PC camera

� VCR

Just make sure you have all the proper hardware and drivers installed before you 
begin.
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Capturing Video and Audio
Now you are ready to capture video or audio footage from practically anything 
digital or analog stored in your library and transforming it into digital footage 
with special effects directly authored from PowerDirector. 

This section will cover video capture devices that are input through your adapter 
cards via video ports such as Video In or S-Video and also audio capture devices 
through ports such as Audio In. However, this section won’t include capturing 
from a DV camcorder. Please refer to "Capturing from DV Camcorders" on page 
50 for more information.

Make sure your devices are installed properly with the proper drivers. Refer to 
their respective user's guide for more information.

1 Start PowerDirector.

2 Click the Capture Mode located on the Modes Wheel. 

3 Depending on the content you would like to capture (audio or video), click 
the appropriate Capture icon (either video or audio or both). 

4 If you clicked Video Capture, you may modify the Video Setup by 
clicking on it. A dialog box will appear. 
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5 Click on the Capture Device drop-down menu to select the appropriate 
video capture device installed on your system. 

6 Select the correct Capture Source. Usually, all the sources will have ports 
located on the capture card. Make sure the connections are secure.

7 If you selected Video Tuner, you may then select either CATV if you have 
a cable connected or Antenna. Select a channel.

8 Click OK.

9 Now, modify the Audio Setup by clicking on it either in Video or Audio 
Capture mode. A dialog box will appear.

10 Click on the Audio Device drop-down menu to select the appropriate audio 
capture device installed on your system. 

11 For the Audio Input, select the right input source (selections here will 
depend on your sound card manufacturer). Click OK.

� If you have an audio CD in your CD-ROM or DVD-ROM drive, 
select the Audio CD for the Audio Input and a new drop-down menu 
will appear to select the audio track. Click OK when you are done.

12 Click Profile Setup and a dialog box will appear.
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13 Click a Name (i.e. profile) or change your Attributes by clicking on the 
drop-down menu and choosing another one. 

14 Click Save As to save the new profile. Name the new profile and click OK. 
To Remove, select a profile and click Remove. After you are done, click 
OK.

Note: If the video display is blank after you have selected to capture video, be 
sure your video device is functioning properly. Other possibilities may be that the 
connections aren't set up properly or you selected the wrong input settings.

15 Click the Time Limit box (optional) to set and then enter the time length.

16 Click the Size Limit to (optional) set the maximum file size of your 
recorded video content.

17 If you are in the Video Capture mode, you may click Snapshot to capture 
still images from your video content. To set your preferences, go to 
"Capture Preferences" on page 42 for more information.

18 Depending on your device, turn it on, press Play or activate any other 
function so that your external capture device will begin capturing or playing 
content that PowerDirector is able to record. When ready, click 
PowerDirector’s Record.

Note: For example, a PC camera would not have to be activated after its power 
is turned on, for it will begin capturing content automatically. 

Note: An audio CD, on the other hand, does not need to be played. Just click 
Record and PowerDirector will begin playing and recording it.

19 Click PowerDirector’s Stop function after finishing your capture. The file 
will now be saved automatically, or appear in your Library or Storyboard. 
Go to "Capture Preferences" on page 42 for more information.
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Capturing Content
Info: Because of the inherent limitations of the Windows operating system in 
handling files over 2 GB, PowerDirector will automatically save and chunk your 
video files into 600 MB files if the file's size is over this limit.
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Capturing from DV Camcorders
Whether your DV is playing video or filming special moments, PowerDirector 
captures in real-time. With the astounding FireWire transfer protocol, you can 
capture crystal clear digital video and audio from your DV camcorder and 
transfer data without any quality loss whatsoever. Refer to "FireWire Adapter 
Cards" on page 7 for more information.

Capturing from a DV camcorder differs in two respects. As you might well be 
aware of, DV camcorders come with two main modes. The first mode is to record 
live content and is referred to as the Camera mode for most brands. The 
alternative mode is the VCR mode (for most brands) where you may play back 
your previously recorded content and navigate through the DV tape. The degree 
of controlling your DV camcorder with PowerDirector differ in these two DV 
modes.

Note: Before starting PowerDirector, make sure all devices are installed properly 
with the proper drivers, your DV camcorder is turned on, is in the correct mode, 
and the FireWire cables are hooked up properly. Refer to the respective user's 
guide for more information.

Capturing from DV Camera Mode
When your DV camcorder is in the Camera mode, PowerDirector may only 
Record into your hard drive, for it will simply capture what your DV camcorder 
is aimed at or what it is recording. For other commands in the Camera mode, you 
will have to rely on your DV camcorder’s controls.

1 Start PowerDirector.

2 Click the Capture Mode located on the Modes Wheel.

3 Click the DV icon. If you’re DV camcorder is hooked up properly along 
with the FireWire cables, turned on, and in the Camera mode (this will 
depend on your DV camcorder’s designation), a live shot from your DV 
camcorder should be displayed in PowerDirector’s Preview window. 
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4 Select a Profile by clicking on it. For more information on selecting 
profiles, go to "Producing Your Movie" on page 79 for more information. 
Click OK.

5 Click the Time Limit box (optional) to set it and then input the maximum 
recording time in minutes and seconds. 

6 Click the Size Limit box (optional) to set it and then input the maximum 
recording size in MB.

7 To begin real-time capture, click PowerDirector’s Record button.

8 Click Stop after finishing your capture. The file will now be automatically 
added to the Library or Storyboard according to your preferences. To set 
your preferences, go to "Capture Preferences" on page 42. 
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Capturing from DV VCR Mode
When your DV camcorder is in VCR mode, PowerDirector has a high degree of 
control. All navigational functionality may be controlled by PowerDirector 
including playing, seeking, pausing, stopping and of course, recording content 
directly from the DV tape. After capturing content from your DV tape with 
PowerDirector, you may apply all the special effects you wish, which have made 
PowerDirector a powerhouse in the arena of video editing. Finally, when it is 
time to produce, PowerDirector provides the luxury of writing your new movie 
directly onto your DV tape! Please refer to "Producing Your Movie" on page 79 
for more information on producing. 

1 Start PowerDirector.

2 Click the Capture Mode located on the Modes Wheel.

3 Click the DV icon. Make sure you’re DV camcorder is hooked up properly 
along with the FireWire cables, is turned on, and in the VCR mode (this 
will depend on your DV camcorder’s designation). The display you are 
viewing in PowerDirector’s Preview window should be exactly as your DV 
camcorder screen.
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Capturing Content
4 Select a Profile by clicking on it. For more information on selecting 
profiles, go to "Producing Your Movie" on page 79 for more information. 
Click OK.

5 To seek to the proper time, drag and release the Shuttle icon. Located to its 
immediate left is the timecode area for the DV tape.

Note: If the DV tape’s timecode is incorrect, then click Seek Tape to verify the 
timecode.

6 You may also navigate with the Play, Next and Previous Frame, Start, 
End, Pause, and Stop buttons. Refer to #4 on page 33 for more information 
on the aforementioned commands.

7 Click the Time Limit box (optional) to set it and then input the maximum 
recording time in minutes and seconds. 

8 Click the Size Limit box (optional) to set it and then input the maximum 
recording size in MB.

9 To begin real-time capture, click Play on your camcorder and then click 
PowerDirector’s Record button when you’re ready. The total recording 
time will be displayed above the DV tape’s timecode area.

10 Click Stop after finishing your capture. The captured file may appear 
directly in your Library or Storyboard depending on preferences. Go to 
"Capture Preferences" on page 42 for more information. 
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Batch Capturing from DV 
Camcorders
When you are in the DV VCR mode, you may select precise scenes you want to 
convert. After selecting a few scenes, you may convert them with one click as 
part of a whole batch of files. Batch capturing is efficient and saves huge amounts 
of time.

1 Start PowerDirector.

2 Click the Capture Mode located on the Modes Wheel.

3 Click the DV icon. Make sure you’re DV camcorder is hooked up properly 
along with the FireWire cables, is turned on, and in the VCR mode (this 
will depend on your DV camcorder’s designation). The display you are 
viewing in PowerDirector’s Preview window should be exactly identical to 
your DV camcorder screen.

4 Click Batch Capturing.
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5 Select a Profile by clicking on its immediate right. For more information on 
selecting profiles, go to "Producing Your Movie" on page 79 for more 
information. Click OK.

6 To shuttle (fast forward/rewind) to the proper time, drag and release the 
Shuttle icon.

7 Click Seek Tape to locate the exact timecode position of the DV tape.

Note: Depending on the specific DV tape, there may be identical timecodes for 
many different scenes on a DV tape (e.g. 00:01:20). This is attributed to the 
resetting of timecodes performed by the author. When seeking tape with 
PowerDirector, it will only seek to the first timecode.

8 You may also navigate with the Play, Next and Previous Frame, Rewind, 
Fast Forward, Pause, and Stop functions of PowerDirector. Refer to #4 on 
page 33 or use your DV camcorder’s navigational buttons.

9 When you have found the beginning of the segment that you would like to 
trim, click Mark In. Navigate to the end of the segment and click Mark 
Out.

10 After they are set, click the Add New Task icon and this batch task will 
appear in the batch box or click Remove Task to delete.

11 Repeat the Mark In and Mark Out steps to add more tasks. To begin 
conversion, select the specific task(s) and click Start Selected Task(s). Or, 
select multiple tasks by keeping <SHIFT> or <CTRL> depressed as you 
click on different tasks.
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12 The batch captured files may appear directly in your Library or Storyboard 
depending on preferences. Go to "Capture Preferences" on page 42 for more 
information.    
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CHAPTER 6:
TRIMMING VIDEO 
AND ADJUSTING 
COLOR

Trim Mode
Generally, after your media files are imported into your library, the next step is to 
trim your video clips or set the time limit for image files. Before production, this 
step is very important in eliminating unwanted portions of your video clip and to 
place more focus on the essential plot of your movie. 

Note: After you have modified your file in this mode, a red line will be displayed 
in the Modes Wheel to indicate this.

Note: Your original media files will not be manipulated in any way when 
trimming files that have been imported into the Library or after it is applied to 
the Storyboard.

1 Select a video clip from the Library by double-clicking on the selected file 
or dragging it into the Preview window. Refer to "Importing into the 
Library" on page 31 for more information on importing.

2 To trim files that have already been applied to the Storyboard, simply select 
the particular clip by double-clicking and it will be displayed in the Preview 
window.

3 Click the Trim Mode located on the Modes Wheel and a dialog box will 
appear. Click OK so that it is automatically applied on the Storyboard.
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Note: Whenever the mode switches from Preview to another mode for the first 
time, a dialog box will appear to notify you that the file will be added to the 
Storyboard automatically.

4 Before setting your trim positions, you may play your file. Go to 
"Previewing your Library Files" on page 33 for more information on 
navigation during playback.

5 Drag and release the Time Slider to find the exact time positions and 
quicken your search. You may also Play, Rewind, Fast Forward, Pause, 
jump to the Start or End of the file, and go to the Next or Previous Frame.

6 To capture the frame as a new image file, click Snapshot. Go to "Capture 
Preferences" on page 42 for more information.

7 Click on the Mark In and Mark Out icons to set your trimming positions 
at the Time Slider position or set them during playback. Or, you may also 
utilize the Time Slider and directly drag the Mark In and Mark Out sliders 
to the position where you would like to begin your trim. 

8 After your Mark In and Mark Out positions have been set, their times will 
be displayed to the right of each respective icon along with the time length 
for this new clip in the bottom right area. The other time slot on the bottom 
left indicates the current position of the Time Slider. 

9 To reset, click Reset Mark In or Reset Mark Out. 

10 To Resize your view, select one of the options from the drop-down menu.

� Stretch: This option will stretch your media file to fill out the screen 
but will not keep the aspect ratio.
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Trimming Video and Adjusting Color
� Crop: This keeps the aspect ratio of your media file and if larger than 
the Preview window, it will crop off the sides.

� 1:1 Fit: This will fit your media file into the Preview window but 
unlike Stretch, it will keep the aspect ratio of the media file and won’t 
crop the image.

� 1:1 Fill: This will fill out the Preview window with the original size 
but will crop the image.

Note: The resize function will not alter your original file but will affect your 
Storyboard clip.

11 Click Revert to return to the original trim (if the clip had already been 
trimmed) or click Clear to start from scratch.

12 When you are satisfied with your trim, click Apply and your trim will be 
applied to your Storyboard. Be sure to set your preferences for applying to 
the Storyboard. Go to "Preferences" on page 40 for more information.

Trim Mode for Image Files
Naturally, image files don’t need to be trimmed. The time duration of the 
appearance of the image file may be set along with the image’s resize if desired.

1 Once your image files have been imported into the Library, double-click on 
an image file or drag it in order to display it in the Preview window. Refer 
to "Importing into the Library" on page 31 for more information on 
importing.

2 To modify files that have already been applied to the Storyboard, simply 
select the particular clip by double-clicking and it will be displayed in the 
Preview window.

3 Click on the Trim Mode from the Modes Wheel and a dialog box will 
appear. Click OK so that it is automatically applied on the Storyboard.

4 To Resize, select one of the options from the drop-down menu.

� Stretch: This option will stretch your media file to fill out the screen 
but will not keep the aspect ratio.

� Crop: This keeps the aspect ratio of your media file and if larger than 
the Preview window, it will crop off the sides.

� 1:1 Fit: This will fit your media file into the Preview window but 
unlike Stretch, it will keep the aspect ratio of the media file and won’t 
crop the image.

� 1:1 Fill: This will fill out the Preview window with the original size 
but will crop the image.
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5 Enter the time for the image to appear in the Duration box by using the 
arrows or inputting a numeral.

6 Click Revert to revert to the original trim.

7 Or click Clear to start over.

8 Click Apply when complete. Be sure to set your preferences for applying to 
the Storyboard. Go to "Preferences" on page 40 for more information.
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Color Mode
Before applying your clips, you may want to adjust your clips’ colors that include 
its brightness, contrast, hue, saturation, and sharpness levels. Go to "Glossary" on 
page 101 for more information on hue and saturation.

Note: After you have modified your file in this mode, a red line will be displayed 
in the Modes Wheel to indicate this.

1 Select a video clip or an image from the Library by double-clicking on the 
selected file or dragging it into the Preview window. Refer to "Importing 
into the Library" on page 31 for more information on importing.

2 To modify files that have already been applied to the Storyboard, simply 
select the particular clip by double-clicking and it will be displayed in the 
Preview window.

3 Click the Color Mode located on the Modes Wheel and a dialog box will 
appear. Click OK so that it is automatically applied on the Storyboard.

Note: Whenever the mode switches from Preview to another mode for the first 
time, a dialog box will appear to notify you that the file will be added to the 
Storyboard automatically.

4 Drag the sliders to the right to increase and left to decrease the color levels. 
This does not apply for Sharpness, where you may only increase its levels 
by dragging right.
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5 Click Revert to revert to the original clip’s effect or click Clear to start 
over. 

6 Click Apply when you are finished. Be sure to set your preferences for 
applying to the Storyboard. Go to "Preferences" on page 40 for more 
information.
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CHAPTER 7:
ADDING TITLES 
AND TRANSITIONS

Titles Mode
Generally, at the beginning of every movie or show, text is involved to convey the 
title, starring and supporting actors, and other information for all those involved 
and whom made the movie possible. When a movie or show wraps up, the full 
spate of credits will be rolled out too.

For smaller movie productions, you may want to inform viewers with textual 
effects instead of just visual effects. PowerDirector allows you to add up to six 
titles for any clip. So, get ready to begin communicating literally like you never 
have before.

Note: After you have modified your file in this mode, a red line will be displayed 
in the Modes Wheel to indicate this.

1 Select a video clip from the Library by double-clicking on the selected file 
or dragging it into the Preview window. Refer to "Importing into the 
Library" on page 31 for more information on importing.

2 To add titles to files that have already been applied to the Storyboard, 
simply select the particular clip by double-clicking and it will be displayed 
in the Preview window.
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3 Click on the Titles Mode on the Modes Wheel and a dialog box will appear. 
Click OK so that it is automatically applied on the Storyboard.

Note: Whenever the mode switches from Preview to another mode for the first 
time, a dialog box will appear to notify you that the file will be added to the 
Storyboard automatically.

4 Click the Fonts icon to set your font format. There are a host of options 
here including Spacing, Color, Font Style, and Alignment. After you are 
finished, click OK.

5 Click on the Add Title icon. A cursor on the first line of the Titles box will 
appear for you to begin typing. Press <Enter> to skip to the next line if you 
wish.
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6 After inputting your text, click outside of the box. The title will be 
displayed in the Titles box along with the Preview window.

7 To select a suitable Title Effect, select a title first and then click on the 
drop-down menu to select. An instant preview will be shown in the Preview 
window.

8 Drag the Effect Length slider to determine the length of time for the effect. 
By increasing the effect’s length (dragging right), which are represented by 
the two orange bars, the Hold Time (i.e. only the text without effects), 
which is represented by the blue bar, will be decreased.

Note: Each chosen title effect vary in terms of duration length.

9 To minimize the duration of an entire title effect (i.e. you don’t want the title 
effect to last the entire duration of the clip), click and drag the Mark In and 
Mark Out sliders located on the outside edge and above the orange bars. 
Or, position the Time Slider at a designated point and then click Mark In or 
Mark Out.
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10 To place a title at a certain area of the screen, simply click on it in the 
Preview window and drag.

11 Click Revert to return to the original titles and their associated effects or 
click Clear to start from scratch.

12 Repeat the above steps to add more titles.

13 To edit or removing titles, click on a title in the Titles box. To edit, click 
twice and a cursor will appear in the box. Begin editing.

14 To remove, select an existing title and then click Remove Title.

15 You may hide titles by unchecking Show All Titles or checking to show all.

16 After you are satisfied with all your titles, click Apply to apply it to the 
Storyboard. Be sure to set your preferences for applying to the Storyboard. 
Go to "Preferences" on page 40 for more information.
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Transitions Mode
Usually appearing naked to the human eye, transitions are a great mood enhancer 
in movies or full-length feature shows and videos. Generally, scene-from-scene, 
simple fades or a direct cut to the next scene is used. To further enhance your 
video, you may want to try one of the many transitional effects PowerDirector 
has provided.

Before you begin, be sure that there are at least two video clips or images that 
have been applied in the Storyboard.

Note: After you have modified your file in this mode, a red line will be displayed 
in the Modes Wheel to indicate this.

1 Click a transition icon located anywhere between two clips from the 
Storyboard.

2 Or, you may select a clip from the Storyboard and then click on the 
Transitions Mode from the Modes Wheel.

Note: Transitions may not be applied to the last clip on the Storyboard.

3 To preview a transitional effect before you apply, place your cursor above a 
given transition in the Library.

4 Select a transition by clicking on it twice or dragging to the appropriate 
point between the selected clip and the clip immediately proceeding it on 
the Storyboard. You may also drag the transition from the Library to the 
Modes Panel. The chosen transition will now appear in the Modes Panel.
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5 Input the Transition Length located in the Modes Panel numerically or 
drag the slider to increase and decrease. The length will vary depending on 
your clips’ duration.

Note: Keep in mind that the length you set will be equally divided amongst the 
two slides. If you set ten seconds, five seconds of the transitional effect will be 
allotted to the end of the first media file while five seconds will be allotted to the 
beginning of the succeeding media file.

Tips: Don’t forget that many of the transitional effects are so radical, that they 
will literally “swallow” up some of your clip’s content. Consequently, be sure 
that your clips have ample time in the beginning and in the end so as not to 
interfere with your clip’s content and that the transition length is not set too long.

6 Click Revert to revert to the original transition effect or click Clear to clear 
all transitions.

7 When you are finished with your selection, click Apply to apply it to the 
Storyboard. Be sure to set your preferences for applying to the Storyboard. 
Go to "Preferences" on page 40 for more information.
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CHAPTER 8:
ADDING AUDIO 
AND PICTURES

Audio Mode
As all amateur or seasoned video professionals know, the soundtrack of your 
movie is incredibly important to set the mood and atmosphere of your movie. For 
exciting scenes, a musical score with a fast beat will serve to outline the hastiness 
and recklessness of the occasion. For tender moments, a beautifully scored song 
touching on romance and playing with your emotions like a concert violinist will 
go a long way in making your post-production a worthy undertaking.

Note: After you have modified your file in this mode, a red line will be displayed 
in the Modes Wheel to indicate this.

1 Select an audio file from the Library by double-clicking on the selected file 
or dragging it into the Preview window. Refer to "Importing into the 
Library" on page 31 for more information on importing.

2 To add audio to clips that have already been applied to the Storyboard, 
simply select the particular clip by double-clicking and it will be displayed 
in the Preview window.

3 Click on the Audio Mode on the Modes Wheel. 

Note: Whenever the mode switches from Preview to another mode for the first 
time, a dialog box will appear to notify you that the file will be added to the 
Storyboard automatically.

4 If your original file or clip contains audio, it will be displayed in the 
uppermost line.
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Note: You are not allowed to trim the audio portion of the original video file.

5 To add more audio files to a certain clip, drag them from the Library into the 
User-Defined box or you may click the Add Audio icon. A flashing 
message will appear in the User-Defined box to show you where you should 
drag the audio file to. Four user-defined audio files are allowed, which will 
be displayed below the original file.

6 To trim the audio, select a particular file and click Trim Audio.

7 Trimming controls are very similar to trimming other media files. Please 
refer to #5 on page 58 for more information. Click Apply and then OK 
when you are finished trimming your audio clip.

8 If you want the audio clip to Fade In or Fade Out, click the corresponding 
option.

9 Adjust the volume by dragging on the Volume Mixing to increase or 
decrease after you have selected the audio file. Drag to the farthest left to 
mute it. Keep in mind that this volume will be combined with the original 
clip’s audio volume (if applicable).

10 Select an audio clip (not including the original) and click Repeat Selected 
Audio File so that the audio file will repeat to the end of the video clip or 
the end of the image file’s duration.
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11 If you want to remove a file, click an audio file and then click Remove 
Audio.

12 Click Revert to return to the original clip’s audio effects (if the clip had 
employed audio clips previously) or click Clear to start from scratch.

13 Click Apply when you are finished to apply it to the Storyboard. Be sure to 
set your preferences for applying to the Storyboard. Go to "Preferences" on 
page 40 for more information.
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Master Audio
To further accentuate the audio aspect of your movie production, you may wish 
to apply a musical score that will act as the background audio for your entire 
movie. The controls and options for the master audio file is very similar to the 
normal Audio Mode where you add files to various clips.

Caution: If you utilize Master Audio in your movie, SVRT will be disabled when 
producing.

1 Click Master Audio located on the Storyboard’s very left. The entire 
Storyboard will be highlighted.

2 The Master Audio controls will be displayed below the Modes Wheel in the 
Modes Panel. Drag an audio file from the Library into the designated box.

3 Click Trim Audio to begin trimming your Master Audio file. Trimming 
controls are very similar to trimming other media files. Please refer to #5 on 
page 58 for more information. Click Apply and then OK when you are 
finished trimming your audio clip.

4 If you want the audio clip to Fade In or Fade Out, click the corresponding 
option.
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5 Adjust the volume by dragging on the Volume Mixing to increase or 
decrease after you have selected the audio file.

6 To Repeat Master Audio, click to check the box so that it will repeat until 
the end of the entire movie.

7 Click Revert to return to the original Master Audio file or click Clear to 
start from scratch.
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Picture-in-Picture Mode
For any of your existing video clips or image clips on the Storyboard, you may 
add a still image or video to the background. Set the transparency level 
depending on your preferences.

Note: After you have modified your file in this mode, a red line will be displayed 
in the Modes Wheel to indicate this.

1 First, select the default picture or video clip from the Library by double-
clicking on the selected file or dragging it into the Preview window. The file 
will be displayed. Refer to "Importing into the Library" on page 31 for more 
information on importing. 

2 Or, you may select a clip that has already been applied to the Storyboard by 
simply selecting the particular clip and it will be displayed in the Preview 
window.

3 Click the Picture-in-Picture (PinP) Mode located on the Modes Wheel and 
a dialog box will appear. Click OK so that it is automatically applied on the 
Storyboard. 

Note: Whenever the mode switches from Preview to another mode for the first 
time, a dialog box will appear to notify you that the file will be added to the 
Storyboard automatically.
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4 A message will flash in the Preview window. Select the second “picture” 
from the Library in the form of an image or video file by dragging it there.

Note: If you already have a PinP file applied to the original clip, a dialog box 
will appear to ask you in replacing your original file after you have dragged the 
new file to the Preview window. Click OK.

5 Click and drag the points located on the edge of the file to enlarge or 
decrease its size. Keep in mind that the Keep Aspect Ratio is checked as 
the default. If you do not want to retain its width-to-length size ratio intact, 
uncheck it.

6 Drag the Transparency slider to make the picture more or less transparent.

7 Click Revert to return to the original clip’s PinP file and its associated 
modifications or click Clear or press <DEL> on your keyboard to start 
from scratch.

8 Click Apply when you are finished to apply it to the Storyboard. Be sure to 
set your preferences for applying to the Storyboard. Go to "Preferences" on 
page 40 for more information.

Applying Image Color Filters
Only for image files in the PinP Mode, you may want to apply a color filter so 
that a specific color of the image file will blend the background of the image with 
the foreground of the original file. This is not applicable for video files. 

1 With the image file selected in the PinP Mode, click Eyedropper to apply 
the color filter. 

2 A dialog box will appear. Now, position the Eyedropper tool over the color 
you want to filter out and then click once to select it. The color box on the 
left displays the current color the Eyedropper is positioned over. The right 
box displays the color that was last filtered. Click OK.
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3 Now, check Apply Color Filter by clicking in the box. To disable this 
function, uncheck by clicking it again.

4 Click Apply when you are finished. Be sure to set your preferences for 
applying to the Storyboard. Go to "Preferences" on page 40 for more 
information.
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Master Watermark
There are times when you wish to add an image that will serve as a visual 
background throughout the movie, which will usually represent the party that has 
created the movie or owns the rights to it. This is a watermark. It may also be a 
TV station logo or the movie title.

Caution: If you utilize Master Watermark in your movie, SVRT will be disabled 
when producing.

1 Click Master Watermark located on the Storyboard’s left side. The entire 
Storyboard will be highlighted.

2 The steps here are extremely to the PinP Mode. Go to #4 on page 75 for the 
rest of the steps.

3 You do not need to click Apply in this mode. Just switch out of the mode 
and your Master Watermark will be set or save your project.

4 To Apply Color Filter, go to "Applying Image Color Filters" on page 75 
for more information.
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CHAPTER 9:
PRODUCING YOUR 
MOVIE

The time has finally arrived for you to produce your own movie. After all your 
hard work of importing media files into your Library, previewing them, 
manipulating them, and applying them to the Storyboard, the production of your 
grand masterpiece is imminent. This chapter will cover MPEG-1, MPEG-2, 
Windows Media and Microsoft AVI formatted video types.

Editing and producing MPEG files and clips is what makes PowerDirector a 
powerhouse in video editing software applications. 

Info: MPEG is an acronym short for the Moving Picture Experts Group which 
belongs to the family of ISO/IEC standards (International Organization for 
Standardization and International Electrotechnical Commission). It is a 
compression technology for digital video and audio signals intended for 
consumer distribution. Please refer to "What Is MPEG?" on page 99 for more 
information.

Many video editing software applications waste valuable time when 
decompressing MPEG files into uncompressed AVI format before the editing 
process. During editing, this process places unnecessary burden on your hard disk 
by requiring a huge amount of disk space when working with uncompressed AVI 
format. After it’s all said and done, when you are ready to produce into MPEG 
format, valuable time is wasted again in compressing your movie!

Not so with PowerDirector’s proprietary technology, SVRT (Smart Video 
Rendering Technology). If your files are originally MPEG, editing will be in 
MPEG format and thus when producing, invaluable time and hard disk space is 
preciously saved when only the edited video portions need to be rendered. This is 
“smart video rendering”.
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Producing MPEG-1 Movies
As mentioned in the previous section, MPEG is the standard format this 
generation for compressed multimedia files with high quality. After you are 
satisfied with your all special effects, trims, audio, etc., and wish to produce a file 
in compressed MPEG format, you are ready for the final stage of your post-
production process. Refer to "What Is MPEG?" on page 99 for more information.

1 Clips should be applied to the Storyboard.

2 Click Produce Movie located on the Modes Wheel. 

3 Select MPEG-1. Click Next.
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4 We recommend that you select the default Smart Video Rendering 
Technology (SVRT) selection to save time. Refer to "Glossary" on page 
101 for more information on this selection’s properties.

Note: If the SVRT is grayed out, it might be that your movie is utilizing Master 
Audio or Master Watermark or does not possess any MPEG files. SVRT is used 
optimally with MPEG files.

5 If you are an advanced user, you may click the second selection MPEG-1 
Video (Constant Bitrate).

6 If you picked the second selection, click on the left drop-down menu and 
choose the group of profiles you want to display, which will include Basic, 
Advanced, Custom, or All. 

7 After selecting a group, select the specific profile. Profile properties will be 
displayed immediately below the chosen profile including the 
recommended processing speeds of your system. If you want better 
resolution or quality but at the expense of hard disk consumed, choose the 
higher quality or higher bitrate profiles.

Tips: If you will be making your own VCDs (burning at a later time), choose a 
VCD profile. For more information on television standards such as NTSC and 
PAL, refer to "NTSC and PAL" on page 100. 
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8 Click Details for more specific information concerning a profile.

9 To create your own profile, go to "Creating Custom MPEG Profiles" on 
page 86.

10 Click Next.

11 For the last step, choose a file name or click Browse to look for the correct 
directory. After finding the directory and typing in the new file name, click 
Save.

12 Check your File Details. Click Finish.

13 During the production, there are viewing options you may set. Go to 
"Preview Preferences" on page 43 for more information. You may also click 
Abort during production.

14 Save you project if you haven’t already by choosing File > Save. Enter the 
file name and click Save. 
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Producing MPEG-2 Movies
As mentioned in the previous section, MPEG is the standard format this 
generation for compressed multimedia files with high quality. After you are 
satisfied with your all special effects, trims, audio, etc., and wish to produce a file 
in compressed MPEG format, you are ready for the final stage of your post-
production process. Refer to "What Is MPEG?" on page 99 for more information.

1 Clips should be applied to the Storyboard.

2 Click Produce Movie located on the Modes Wheel. 

3 Select MPEG-2. Click Next.
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4 We recommend that you select the default SVRT selection to save time. 
Refer to "Glossary" on page 101 for more information on this selection’s 
properties.

Note: If the SVRT is grayed out, it might be that your movie is utilizing Master 
Audio or Master Watermark or does not possess any MPEG files. SVRT is used 
optimally with MPEG files.

5 If you are an advanced user, you may click the second selection MPEG-2 
Video (Constant Bitrate).

6 If you picked the second selection, click on the left drop-down menu and 
choose the group of profiles you want to display, which will include Basic, 
Advanced, Custom, or All. 

7 After selecting a group, select the specific profile. Profile properties will be 
displayed immediately below the chosen profile including the 
recommended processing speeds of your system. If you want better 
resolution or quality but at the expense of hard disk consumed, choose the 
higher quality or higher bitrate profiles.

Note: If you will be making your own DVDs (burning at a later time), choose a 
DVD profile. 
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8 Click Details for more specific information concerning a profile.

9 To create your own profile, go to "Creating Custom MPEG Profiles" on 
page 86.

10 Click Next.

11 For the last step, choose a file name or click Browse to look for the correct 
directory. After finding the directory and typing in the new file name, click 
Save.

12 Check your File Details. Click Finish.

13 During the production, there are viewing options you may set. Go to 
"Preview Preferences" on page 43 for more information. You may also click 
Abort during production.

14 Save you project if you haven’t already by choosing File > Save. Enter the 
file name and click Save.
85



Chapter 9
Creating Custom MPEG Profiles
1 While in the Producing Movie 

process, after you have chosen 
MPEG as your video type and 
selected MPEG-1/2 Video 
(Constant Bitrate), select an existing 
MPEG profile that is closely 
associated with your new profile. 
Then, click New in order to create a 
new MPEG profile.

2 Type in a profile name and edit the 
description. For information on the 
Profile Properties, go to "Glossary" 
on page 101 for more information.

3 Click on the Video tab.

4 Select a Video Size by clicking on the 
drop-down menu.

5 Drag the slider to set your Video 
Compression Rate. The higher the 
kbps, the less the compression with 
better quality, but more disk space 
will be consumed.

6 Some Advanced Settings may be 
checked as default depending on the 
profile you are copying from:

� Smoothing: Check for a 
smoother image if you find 
video content is too fine and on 
the grainy side.

� Noise Removal: This removes 
video artifacts such as white 
noise from video signals. 

� Deinterlacing: Combines two interlaced fields into a single frame and 
render them at 30 frames per second (fps). Deinterlacing is done to 
remove artifacts and improve the quality of encoded video. 

7 Drag the Speed Quality Indicator to the left for higher speed but which 
will sacrifice quality or to the right for better quality but at a slower speed. 
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8 Click on the Audio tab.

9 The default MPEG Audio 
Compression setting will be Layer II 
stereo. For the Audio Compression 
Rate, like its Video counterpart, the 
higher the kbps, the less the 
compression with better quality, but 
more disk space will be consumed.

10 Click OK.

11 To select your new profile, select 
Custom from the profile group menu 
and then select the profile.

12 To edit existing profiles, select the 
right custom profile and click Edit. 
Click Delete after you have selected 
the custom profile you wish to delete.

13 Return to the production process.
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Producing Windows Media 
Movies
Streaming technology has grown by leaps and bounds since its increasing usage 
from the last decade by providing a medium that is controlled by the content 
provider and therefore is free of copyright issues. And it’s only getting started. 

Info: Streaming utilizes video scaling, compression techniques, and network 
protocols in order to transmit files from a Web server (where the streaming file is 
stored) to the client (your hard drive). The concept of streaming is relatively easy: 
the file is broken up into data packets, compressed, and sent over the Internet in a 
stream, or a series of related packets, along with the audio data if applicable. 

The client must have a player in order to decompress the packets, display the 
video data, and send audio data to the speakers via the sound card. The player 
will first buffer the packets, meaning the packets are downloaded and stored in a 
buffer before playback begins. This ensures smooth playback in case of breaks or 
interference due to instable Internet connections. Thus, the client and its player 
does not have to wait for the entire file to download in order to begin playing the 
individual data packets. 

Windows Media is a proprietary streaming audio/video format typically used to 
download and play files or to stream content. It is the main streaming format used 
for Microsoft's Windows Media Player.

The Windows Media profiles are best for streaming content across bandwidths 
where you, the presenter, would like as many flexible selections as possible. 
Profiles range from the more basic Internet connection speeds to full-fledged 
broadband, audio only, and profiles containing single to multiple video streams. 

After you are satisfied with your all special effects, trims, audio, etc., and wish to 
produce a file in compressed streaming Windows Media format, you are ready 
for the final stage of your post-production process.

1 Click Produce Movie located on the Modes Wheel. 
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2 There will be a brief description of each format to the right of each 
selection. After making the Windows Media selection, click Next. 

3 Now select a profile depending on what type of connection speed you will 
be utilizing when streaming your file to your audience. Click on the drop-
down menu and select a profile. Profile descriptions and properties will be 
displayed immediately below the chosen profile. Go to "Glossary" on page 
101 for more details. Click Next.
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4 For the last step, choose a file name or click Browse to look for the correct 
directory. After finding the directory and typing in the new file name, click 
Save. 

5 Check your File Details. Click Finish.

6 Save you project if you haven’t already by choosing File > Save. Enter the 
file name and click Save. 
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Producing Microsoft AVI Movies
PowerDirector has the robust feature of writing directly to your DV tape in AVI 
format when producing. This will include all your manipulation, modifications 
and special effects and is just another way of making your production more 
mobile and timeless. You may also produce in uncompressed AVI format to your 
hard drive.

1 Click Produce Movie located on the Modes Wheel. 

2 There will be a brief description of the Microsoft AVI format located to the 
right of the selection. Select it and click Next. 

3 For the Profile field, click on the left drop-down menu to display the profile 
group. The DV group consists of DV format profiles. Refer to "The DV 
Format: A Brief History" on page 2 for more information. For more 
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information on television standards such as NTSC and PAL, refer to "NTSC 
and PAL" on page 100. 

4 The Windows group is the uncompressed AVI format that will take up a 
large amount of hard disk but is used for editing by some video editing 
software applications and also writing to VHS tapes or for TV broadcast.

5 After selecting the profile group, select the specific profile with the right 
drop-down menu. Profile properties will be displayed immediately below 
the chosen profile. Click Details for more information on a specific profile.

6 To adjust and modify a Windows AVI profile, go to "Setting AVI Profiles" 
on page 93.

7 If your FireWire connection is ready, your DV camcorder is on, and your 
DV tape is in place, check Write to DV Tape to directly write your entire 
production onto your camcorder’s tape. Click Next.

� If you decided to Write to DV Tape, after your movie is produced 
(hard disk version), the DV Tape dialog box will be displayed. Click 
Show Preview to preview when writing and then click Start. Click 
Close after it is complete.
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8 For the last step, enter a file name or click Browse to look for the correct 
directory. After finding the directory and typing in the new file name, click 
Save.

9 Check your File Details. Click Finish.

10 Save you project if you haven’t already by choosing File > Save. Enter the 
file name and click Save. 

Setting AVI Profiles
You may set the parameters of default Windows AVI profiles. For more 
information on the individual settings, go to "Glossary" on page 101 for more 
information.
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1 While in the Producing Movie process, after you have chosen Microsoft 
AVI as your video type, select an existing AVI profile to set.

Note: You may not set DV profiles.

2 Click Setting. 

3 The Compression tab is the 
default. Select a Compression 
Codec by clicking on the drop-
down menu. Refer to "codec" on 
page 101 for more information.

4 The Key Frame is unavailable to 
be set. It is defined as a frame in 
a video sequence that does not 
require information from a 
previous frame for 
decompression. The more the 
key frames, the better the quality 
but at the expense of disk space.

5 Click on the Data Rate drop-down menu and select one. The higher kbps, 
the better quality but at the expense of hard disk consumed. 

6 Select the Composition if you only prefer video or audio.

7 Drag the slider to set your Quality.

8 Click on the Video/Audio 
Settings tab. Go to "Glossary" 
on page 101 for more 
information on specific terms. 

9 Select a Frames x per second by 
clicking on the drop-down menu. 
The more motion you have in 
your video content, the higher 
the frame rate setting should be. 
The standard TV frame rate (e.g. 
NTSC) is 30.

10 Select a Video Size by clicking 
on the drop-down menu.

11 Select a Color by clicking on the 
drop-down menu.

12 For the Audio Setting, click on the drop-down menu for Format and 
Attributes and select for each one. PCM is the default. Go to "PCM" on 
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page 103 for more information. For the attributes, the higher the Hz, the 
better quality but at the expense of hard disk space.

13 Click OK.

14 Return to the production process.  
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CHAPTER 10:
TECHNICAL 
SUPPORT

Before asking CyberLink Corp. for technical support, please refer to this user's 
guide or online help for more information. You may also contact your local 
distributor/dealer. If your problem is still not resolved, the following sections 
provide ways to obtain technical support.  

Web Support
Solutions to your problem are available 24 hours a day at our Web sites in 
Taiwan, USA, or Japan:

www.gocyberlink.com

www.cli.co.jp

You may also find solutions in the FAQ section or at our Web sites. In addition to 
frequently asked questions, we also provide troubleshooting techniques, the latest 
in product news, and other relevant information.

Email/Fax Support
In order to answer your technical questions as quickly as possible, please send 
email to: powerdirector@gocyberlink.com or visit us at 
support.gocyberlink.com. Or fax us at: (886) 2-8667-1467.

Note: Technical support is only offered to registered users, so please make sure to 
jot down your serial number located on your CD case when emailing or faxing. 
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Telephone Support
You are welcome to call the CyberLink's Technical Support Hotline at (886) 2-
8667-1298. Phone support hours are Monday to Friday, 9:00 AM-5:00 PM (GMT 
+8:00) Taiwan local time excluding holidays. When calling for support, please 
have your computer ready and provide us with the following information:

� your registered serial number 

� the product version 

� Windows' OS version

� hardware types (capture card, sound card, VGA card) and their specifications

� warning messages displayed

� detailed problem description and when it occurred

Note: Technical support is only offered to registered users, so please make sure 
your serial number is ready when calling. 
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APPENDIX A

What Is MPEG?
MPEG, simply, is an acronym short for the Moving Picture Experts Group which 
belongs to the family of ISO/IEC standards (International Organization for 
Standardization and International Electrotechnical Commission). It is a 
compression technology for digital video and audio signals intended for 
consumer distribution. Included in the MPEG family are: 

� MPEG-1 (Audio/Video) 

� MP3 or MPEG-1 Audio Layer 3 (Audio) 

� MPEG-2 (Audio/Video) 

� MPEG-4 (Interactive Multimedia System) 

� MPEG-7 (Multimedia Database & Retrieval) 

MPEG technology is defined as a bit-stream representation for synchronized 
digital audio and digital non-interlaced or interlaced (MPEG-2 includes both) 
video compressed to fit into a certain bandwidth: 

� MPEG-1 -- 1.5-4-0 Mbps (megabits per second) 

� MPEG-2 -- 4.0-10.0 Mbps 

MPEG is responsible for multiplexing and synchronizing one video stream with a 
single or multiple audio streams. MPEG-1 was designed to reproduce VHS/VCR 
quality in a digital format, while the MPEG-2 concept, similar to MPEG-1, is 
intended to cover a wider range of applications including DVD quality and its 
primary goal of an all-digital transmission of broadcast TV at coded bitrates 
between 4 and 9 Mbps. 
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NTSC and PAL 
The NTSC (National Television Systems Committee) and PAL (Phase Alteration 
Line) are television standards used for commercial television broadcasting 
around the world. Both NTSC and PAL use interlaced content at thirty frames per 
second (approx. 60 fields) and 25 frames per second (approx. 50 fields) 
respectively. 

Because fields in interlaced signals are independent of other fields within a given 
frame, problems arise when two fields containing different imagery data are 
interleaved for display on non-interlaced computer monitors. When video 
imagery with superfluous movement is displayed, it usually causes motion 
artifacts (visual imperfections). DVD titles whose content originates directly 
from films produced from Hollywood studios (24 frames/second) won't possess 
Motion Artifacts.
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ASF Short for Advanced Streaming Format, a streaming multimedia file 
format developed by Microsoft for Windows 98. Term is currently used 
interchangeably with WMA and WMV.

bitrate Bitrate denotes the average number of bits that one second of video/audio 
data will consume.

codec Short for video COmpression and DECompression. Each codec uses a 
different algorithm to compress and decompress video data. Without 
codecs, storing and playing back digital video would be impractical. 
Common codecs include Indeo, Cinepak, RLE, MS Video 1, and MPEG.

deinterlace Deinterlaces interlaced video content, especially from TV signals or 
before capturing video content (see interlace for more details). 

DSL See xDSL.

DV Digital Video. Refers to the capturing, manipulation and storage of video 
in digital formats. The DV format is an international standard intended 
for consumer use created back in 1995 by a consortium of companies.

DVD Digital Versatile Disc. DVD is a high capacity CD-size disc for video, 
multimedia, games and audio applications.

flip video This option is for certain video formats (such as YUY2) provided by 
some hardware capture devices which will might be displayed as upside-
down during recording.

fps Frames Per Second. A measure of how much information is used to store 
and display motion video. The term applies equally to film video and 
digital video. Each frame is a still image; displaying frames in quick 
succession creates the illusion of motion. The more frames per second 
(fps), the smoother the motion appears. In general, the minimum fps 
needed to avoid jerky motion is about 30. Some computer video formats, 
such as AVI, provide only 15 frames per second.
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frame rate For video content, the frame rate measures how many still frames per 
second. The higher the better when capturing video content with motion.

GOP Group of Pictures. A MPEG compression technology, the GOP concept 
reduces the temporal redundancy across frames (from frame to frame) for 
video content and consists of I, B, P frames.

hue the attribute of colors that permits them to be classed as red, yellow, 
green, blue, or an intermediate between any contiguous pair of these 
colors. 

I-frame A.k.a. intra pictures, I-frame is typically the first frame of each GOP 
(apart of video compression technology used by MPEG), is moderately 
compressed, and serves as the reference points for random access and can 
be likened to images.

interlaced video 
content

Describes video content within a given frame where there are 2 imagery 
data fields, even and odd, that is scanned separately (e.g. NTSC and PAL 
television signals). This usually poses a problem when interlaced content 
meets non-interlaced mediums like computer monitors, which only 
displays non-interlaced content.

ISDN Integrated Services Digital Network. Provides a user up to 56 kbps of 
data bandwidth on a phone line that is also used for voice, or up to 128 
kbps if the line is only used for data.

kbps Kilobits per second. See bitrate.

kHz Kilohertz. Hertz (Hz) is a unit of frequency equal to one cycle per second. 
One kHz is 1000 complete cycles per second.

LAN Local Area Network. A computer network that spans a relatively small 
area. Most LANs are confined to a single building or group of buildings 
and mainly connect workstations and personal computers. 

MBR Multibitrate codecs allow several streams of different bitrates to be 
bundled into one file. The streaming server then communicates with the 
end user's media player to determine the optimum speed for delivery.

mono Mono is a single audio channel for lowest bitrate consumption. 

MPEG Moving Picture Experts Group. A family of international standards used 
for coding audio/video information into digital format. Currently, MPEG-
2 is the standard for digital video formats and MP3 for strictly digital 
audio formats.

non-interlaced 
video content

Describes video content within a given frame that does not consist of 
distinct imagery data fields. (e.g. computer monitors)
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noise removal Removes video artifacts such as white noise from video signals. 

NTSC National Television Systems Committee. Is a standard format adopted by 
the FCC for television broadcasts in the United States, Japan, Canada, 
and Mexico. Specs: 525 lines of resolution per frame at 30 fps.; 60 Hz 
field frequency; requires a 6 MHz analog channel for transmission.

PAL Phase Alteration Line. Is the standard format for television broadcasts in 
Germany, Great Britain, South America, Australia, and most of Western 
European and Asian countries.

PCM Pulse Code Modulation. Is a sampling technique for digitizing analog 
signals, especially audio signals. PCM samples the signal 8000 times a 
second; each sample is represented by 8 bits for a total of 64 kbps. There 
are two standards for coding the sample level. The Mu-Law standard is 
used in North America and Japan while the A-Law standard is use in 
most other countries.

resolution Measured in lines or megahertz for monitors, it is the maximum number 
of pixels that can be displayed expressed as (number of horizontal pixels) 
x (number of vertical pixels), i.e., 1024x768.

sampling rate Sampling rate determines the sound frequency range (corresponding to 
pitch), which can be represented in digital waveform. The range of 
frequencies represented in a waveform is often called its bandwidth. 

saturation Is chromatic purity: freedom from dilution with white.

smoothing Smooths out image if you find video content is too fine and on the grainy 
side.

stereo Two independent audio channels but bitrate remains constant while the 
channels' split may vary. 

SVRT Smart Video Rendering Technology. A proprietary CyberLink 
technology, SVRT saves vast amounts of time when producing movies 
that contain compressed MPEG files because it only renders edited 
portions. This preserves the quality of unrendered video portions of the 
original MPEG files.

VCD Video Compact Disc. Generally for video applications employing 
MPEG-1 technology, video quality is not as detailed as DVD and has 
similar technology to that of audio CDs.

Windows Media 
Format

This format is optimized for streaming and playing back audio, video, 
and script data and is primarily used in streaming presentations over the 
Internet. The main format used is .WMV in combination with Microsoft's 
Windows Media Player.
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Windows Media 
Services Server

The Windows Media Services server offers the ability to provide 
multimedia content to a large number of clients using .WMV, .ASF, 
.WMA, .MP3 and .WAV formats. It is for the expanded use of streaming 
media such as live broadcasting and intelligent streaming and is, by 
default, the best way to stream media since it was designed especially for 
streaming. It also provides sufficient tools and support for traffic 
management and broadcasting streaming services. This differs from 
HTTP (Hypertext Transfer Protocol) streaming, which is directly 
streamed from Web servers. 

WMA Windows Media Audio. A Windows Media proprietary streaming audio 
format typically used to download and play files or to stream content.

WMV Windows Media Video. A Windows Media proprietary streaming audio/
video format typically used to download and play files or to stream 
content and is the main streaming format used for Microsoft's Windows 
Media Player. 

xDSL Refers collectively to all types of Digital Subscriber Lines, the two main 
categories being ADSL and SDSL. Two other types of xDSL 
technologies are High-data-rate DSL (HDSL) and Symmetric DSL 
(SDSL). DSL technologies use sophisticated modulation schemes to pack 
data onto copper wires. They are sometimes referred to as last-mile 
technologies because they are used only for connections from a telephone 
switching station to a home or office, not between switching stations.
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setting profiles of 93–95
audio setting 94
color 94
composition 94
compression 94
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compression codec 94
data rate 94
frames per second 94
key frame 94
quality 94
video size 94

writing in 91

B
bandwidth 5, 88, 99, 102, 103
batch capturing 54–56

See also Capture Mode, DV capture
bitrate 101
brightness 61
buffer 88

C
cables 9

audio Y-adapter 9
composite (RCA) video 9
FireWire 10
line in 8
RCA stereo 9
RCA-to-RCA stereo 9
S-Video 9
TV 12

camcorders 2, 10, 12
analog. See analog, camcorders
DV 4, 45, 50–56

batch capturing from. See batch cap-
turing

Camera mode 50, 50–51
connecting to 10
VCR mode 50, 52–53, 54

FireWire cable 10
Hi-8 12
VHS 12
with FireWire adapter cards 7

capture cards 4, 6, 11, 45, 98
selecting source 47
video. See also video capture devices

capture destination. See preferences, cap-

ture destination
Capture Mode 45–56

audio capture 20, 47
audio CD source 47
device setup 47
input setup 47
profile setup 47
setup 47

capturing selection 47
capturing video and audio 46–49
DV capture 20, 50–53

adding batch task 22, 55
batch capturing 22, 54–56
Camera mode 50–51
instant capturing 22
marking in 21, 55
marking out 21, 55
profiles 51, 53, 55
removing batch task 22, 55
seek tape 21, 53, 55
shuttling 21, 53, 55
starting batch task 22, 55
total time 21, 53
trimming batch files 55
VCR mode 52–53
visual overview 21

menu 38
recording 48, 51, 53
size limit 48, 51, 53
time limit 48, 51, 53
video capture 20, 46

antenna 47
CATV 47
device setup 47
setup 46
snapshot 48
tuner source 47

visual overview 15, 20
capture preferences. See preferences, cap-

ture
chunking video files 49
clearing. See specific mode for details
codec 101, 102

compression 94
Color Mode 61

applying 62
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clearing 26, 62
increasing levels 61
reverting 26, 62
visual overview 15, 26

composite 12
port 6, 7, 9
video cable 9

composition 94
compression 87, 101

audio rate 87
codec 94
setting 94
techniques of 88
technology of 79, 102
video rate 86

connectors. See cables
contrast 61
cropping

images 59
video 59

custom MPEG profiles
See MPEG, custom profiles of

D
data packets 88
data rate 94
deinterlacing 86, 101
deleting MPEG profiles 87
demodulating video signals 7
digital camera 4, 45
display preferences. See preferences, dis-

play
DSL 101
DV 3, 101

camcorders 4, 10
Camera mode. See camcorders, DV
capturing from 50–56
DVCAM format 2
DVCPRO format 2
VCR mode. See camcorders, DV
See also camcorders, DV

cameras 7
Capture Mode of 38

visual overview 21

See also Capture Mode, DV capture
capturing source of 20
format of 2–3, 12
profiles 91
tape

timecode 21, 53, 55
writing to 91, 92

transference of 5
universe of 2

DVD 101

E
editing MPEG profiles 87
end of file 17, 33, 58
exiting PowerDirector 14
exporting 38

F
FireWire 3, 4, 5, 7, 10, 45, 50

adapter cards 7
cables 10

flip video 101
frame rate. See frames per second.
frames per second 5, 86, 100, 101

G
general preferences. See preferences, gener-

al
GOP 102
graphics cards 8

H
hardware requirements. See system require-

ments, hardware
headphones 8
hold time 65
hue 61, 102
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I
IEEE 1394. See FireWire
I-frame 102
image color filters. See applying, image col-

or filters
importing files. See Library, importing me-

dia
installing primer 11
intelligent streaming 104
interlaced video content 99, 100, 102

See also non-interlaced video content
i-Power 14, 39
ISDN 102

K
kbps 102
key frame 94
kHz 102

L
LAN 102
Library

displaying as file details 16, 32
displaying as large icons 16, 32
importing media 16, 31–32, 38
showing all audio files 16, 32
showing all image files 16, 32
showing all media files 16, 32
showing all video files 16, 32
visual overview 16

M
main controls 14
marking in

See Capture Mode, DV capture
See Titles Mode, marking in
See Trim Mode, marking in

marking out
See Capture Mode, DV capture

See Titles Mode, marking out
See Trim Mode, marking out

Master Audio 19, 72–73
clearing 73
fade in 72
fade out 72
repeating 73
reverting 73
trimming in 72

applying 72
volume mixing 73

Master Watermark 19, 77
applying color filter 77

MBR 102
menu 38–39

edit 38
file 38
help 39
modes 39
Storyboard 39

microphone 8
minimizing PowerDirector 14
Modes Wheel

visual overview 15
Modes. See specific mode
mono 102
MPEG 1, 5, 79, 99, 101, 102

audio compression 87
compared to DV format 2
profiles 81, 82, 84, 85

custom 86–87
MPEG-1 103

producing movies of. See producing, 
MPEG-1 movies

MPEG-2 102
producing movies of. See producing, 

MPEG-2 movies

N
networks

ISDN 102
local area 102
protocols 88

new project 38
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next frame 17, 33
noise removal 86, 103
non-interlaced video content 99, 100, 102
non-linear editing 3
NTSC 7, 12, 94, 100, 102, 103

O
opening project 38

P
PAL 7, 12, 100, 102, 103
pausing 17, 33, 58
PC camera 4, 45, 48
PCI 5, 6

capture cards 4, 45
interface cards 7
sound cards 8
video graphics cards 8

PCM 103
Picture-in-Picture Mode 74–76

applying 75
applying image color filter 27, 75
clearing 27, 75
keeping aspect ratio 75
reverting 27, 75
transparency setting 75
visual overview 15, 27

playing files 17, 33
playing movie 19, 36, 43
ports 5, 7, 47

A/V In and Out 6
audio 8
composite 6, 7, 9
S-Video 6, 9
TV 7
USB 5
video 12

preferences 40–43
capture 42–43

autosaving 42
destination of 42

display

Library tool tips 41
general

applying clip preferences 40
default directory 40

preview
clip 43
production process 43
window size 43

Preview Mode
preferences 41
visual overview 15
See also previewing, Library files

Preview Window
visual overview 17

previewing 32
during production 19, 37, 43
Library files 33–34
preferences. See preferences, preview
title effects 65
transitions 67
when writing to DV tape 92

previous frame 18, 33, 58
producing 35, 79–95

Microsoft AVI movies 91–93
MPEG-1 movies 80–82
MPEG-2 movies 83–85
preferences 43
profiles. See profiles
visual overview 15
Windows Media movies 88–90

profiles
AVI. See AVI format, setting profiles of
capture setup of. See Capture Mode
MPEG. See MPEG, profiles
Windows Media. See Windows Media, 

profiles

R
recording 18, 21

audio CD 48
Capture Mode. See Capture Mode, 

recording
upside-down 101

removing
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audio files. See Audio Mode, removing 
audio files

batch task. See Capture Mode, DV 
capture

titles. See Titles Mode, removing titles
resizing

images. See Trim Mode, for image files
video. See Trim Mode

resizing
resolution 103
reverting. See specific mode for details

S
sampling rate 103
saturation 61, 103
saving project 38, 82, 85, 90, 93
SECAM 7
seek tape. See Capture Mode, DV capture
setup

See Capture Mode, audio capture
See Capture Mode, video capture

sharpness 61
shuttling 21, 53
size limit. See Capture Mode, size limit
Smart Video Rendering Technology 1, 79, 

81, 84
smoothing 86, 103
snapshot 22, 23, 48, 58

preferences 42
to clipboard 42
to file 42
to wallpaper 42

Sony iLink 5, 10
sound cards 7, 8, 11, 88, 98
speakers 8, 88
speed quality indicator 86
start of file 17, 33, 58
stereo 103
stopping

Capture Mode 48, 51, 53
files 17, 21, 33

Storyboard
activating Master Audio 19
activating Master Watermark 19

applying audio files to 35
applying to. See applying, to Storyboard
copying from 36, 38
cutting from 36, 38
deleting from 38
display preferences 41
functions of 35–37

moving clips 35
removing clips 36

going to 36, 39
menu 39
pasting on 36, 38
playing movie 19, 36
preferences 43
scrolling left 19
scrolling right 19
visual overview 19

streaming 103
ASF format 101
format of 104
intelligent streaming. See intelligent 

streaming
requirements for 4
server 102
technology 88

stretching
images 59
video 58

S-VHS 12
S-Video 7, 12, 46

cable 9
port 9
signal format 6

system requirements 4
hardware 4

T
technical support 97
time limit. See Capture Mode, time limit
time slider 23, 33, 58, 65
timecode. See DV, tape
Titles Mode 63–66

adding titles 1, 25, 64
applying 66
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clearing effects 25, 66
marking in 25, 65
marking out 25, 65
removing titles 25, 66
reverting effects 25, 66
selecting title effects 65

effect length 65
hold time 65
previewing 65

setting fonts 25, 64
showing all titles 66
visual overview 15, 25

transferring
between DV camcorders 10
video from analog to digital 6

Transitions Mode 67–68
applying 68
clearing effects 29, 68
previewing 67
reverting effects 29, 68
transition length 68
visual overview 15, 29

Trim Mode 57–59
applying 59
clearing 24, 59
for image files 59–60

clearing 60
duration setting 60
resizing 59
reverting 60

marking in 23, 58
resetting 23, 58

marking out 23, 58
resetting 23, 58

resizing video 58
reverting 24, 59
snapshot 22, 23
total trim time 23
visual overview 15, 23

trimming
audio files. See Audio Mode, trimming 

audio files
batch files. See Capture Mode, DV 

capture
files. See Trim Mode

TV

antenna 12, 47
broadcast 99

producing for 92
cable 12
capturing from 47
frame rate 94
interlaced signals 101
ports 6, 7
signal formats 12
station logos 77
tuner cards 4, 7, 11, 45

U
USB 4, 45

interface 5, 6

V
VCD 103
VCR 4, 12, 45

composite signals 12
Hi-8 12
MPEG-1 quality 99
transferring from 6

VGA card 98
video capture devices 4, 6–7, 45, 46

selecting of 47
setup of 5

video capture. See Capture Mode, video 
capture

video compression rate. See compression, 
video rate

video editing 2
software 1, 3, 79

video scaling 88
video setup. See Capture Mode, video cap-

ture
video signal formats 12

composite. See composite, video signal 
format

S-Video. See S-Video, video signal 
format

television See television, video signal 
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format
video size 86, 94
video sources’ connection 11
volume

adjusting globally 14
mixing of. See Audio Mode, volume 

mixing

W
watermark. See Master Watermark
Web server 88, 104
Windows Media 88, 103

Audio (WMA) 104
Player 88, 103, 104
profiles 88, 89
Services server 104
Video (WMV) 104

Windows OS
limitations of 49
system requirements. See system 

requirements
WMA 104
WMV 104
writing to DV tape. See DV, tape

X
xDSL 104
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